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1 Introduction

1.1 Add-onModule RF-STEEL FatigueMembers

The fatigue designs according to EN 1993-1-9 [1] are based on the so-called nominal stress concept.
This method analyzes the influence of material fatigue on a structure. Many damages in a steel
structure are affiliated to recurring effects stressing the particular points of the construction until
the fatigue failure occurs. The RF-STEEL Fatigue Members add-on module performs the fatigue
designs using the method of damage equivalent factors.

The following useful features facilitate the work with the add-on module:

• Determination of stress ranges for selected load cases, load or result combinations

• Free assignment of detail categories to the stress points of cross-sections

• User-defined specification of the damage equivalent factors

Since RF-STEEL Fatigue Members is integrated in the main program, the general input data and
internal forces are already available for the design. It is possible to evaluate designs and stress
ranges graphically in the RFEM work window and to associate them in the global printout report.

The analysis determines the maximal design ratios of sets of members. Furthermore, RF-STEEL
FatigueMembers allows an automatic cross-section optimization including the export of modified
cross-section to RFEM.

Using the design cases, you can analyze different types of stress designs. A parts list with quantity
surveying completes the design.

We wish you enjoyment and success with RF-STEEL Fatigue Members.

Your DLUBALTeam
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1.2 Using theManual

Topics like installation, graphical user interface, results evaluation, and printout are described
in detail in the manual of the main program RFEM. The present manual focuses on typical features
of the RF-STEEL Fatigue Members add-on module.

The descriptions in this manual follow the sequence and structure of themodule's input and result
windows. In the text, the describedbuttons are given in square brackets, for example [Viewmode].
At the same time, they are pictured on the left. Expressions appearing in dialog boxes, windows,
and menus are set in italics to clarify the explanation.

At the end of the manual, you find the index. However, if you still cannot find what you are
looking for, please check our website www.dlubal.com where you can go through our FAQ pages
by selecting particular criteria.

1.3 OpeningRF-STEEL FatigueMembersAdd-onModule

RFEM provides the following options to open the RF-STEEL Fatigue Members add-on module.

Menu
To open the program from the RFEMmenu bar, click

Add-onModules → Design - Steel → RF-STEEL FatigueMembers.

Figure 1.1: Menu: Add-onModules→Design - Steel→ RF-STEEL FatigueMembers
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Navigator
As an alternative, you can open the add-on module in the Data navigator by clicking

Add-onModules → RF-STEEL FatigueMembers.

Figure 1.2: Data navigator: Add-onModules→ RF-STEEL FatigueMembers

Panel
If results from RF-STEEL Fatigue Members are already available in the RFEMmodel, you can also
open the design modules from the panel:

Set the relevant design case in the load case list of the RFEM toolbar. Click [Show Results] button
to graphically display the stresses and stress ratios.

When the result display is activated, the panel is available, too. Now you can use the [RF-STEEL
Fatigue Members] button in the panel to open the module.

Figure 1.3: Panel button [RF-STEEL Fatigue Members]



2 Theoretical Principles

©Dlubal Software GmbH 2015

6

2

2 Theoretical Principles

2.1 Design Concept

The fatigue designs according to EN 1993-1-9 [1] are based on the so-called nominal stress concept.
The internal forces are determined according to the structural analysis for members; the stresses
are calculated according to the mechanics of materials at the location where the crack formation
is expected. In fatigue design, the nominal stress ranges 𝛥𝜎 and 𝛥𝜏 , as a result of the actions, are
compared with design values of the fatigue strength 𝛥𝜎R and 𝛥𝜏R. Furthermore, the concept of
the partial safety factors is valid in [1]. The partial safety factor 𝛾Mf for the fatigue strength is graded
according to the reliability concept and the possible consequences of failure. The following table
shows the recommendations:

Figure 2.1: EN 1993-1-9, Table 3.1

The stresses on the action side are to be determined by a serviceability level. For the partial safety
factor 𝛾Ff, the value 𝛾Mf = 1.0 applies to the actions.

The Standard [1] provides the following design methods:

• Design with fatigue strength

• Design by means of damage accumulation

• Design with damage equivalent factors

In the RF-STEEL Fatigue Members add-on module, the design is carried out by means of damage
equivalent factors. Therefore, only this design method is described in the manual.
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2.2 Design with Damage Equivalent Factors

This method represents the standard method according to [1]. The damage equivalent stress
ranges 𝛥𝜎E,2 and 𝛥𝜏E,2 related to 2 ⋅ 106 stress cycles are to be contrasted with the limit values
of the fatigue strength 𝛥𝜎C or 𝛥𝜏C for 2 ⋅ 106 cycles of the corresponding detail category under
consideration of partial safety factors.

2.2.1 Design Equations

Limitation of stress ranges

According to [1], Eq. 8.1, the stress ranges for normal and shear stresses are limited as follows:

𝛥𝜎 ≤ 1.5 ⋅ 𝑓𝑦 (2.1)

𝛥𝜏 ≤
1.5 ⋅ 𝑓𝑦√

3
(2.2)

Fatigue designs

Fatigue designs for normal and shear stresses are limited according to [1], Eq. 8.2 as follows:

𝛾𝐹 𝑓 ⋅ 𝛥𝜎𝐸 ,2

𝛥𝜎𝐶/𝛾𝑀 𝑓
≤ 1.0 (2.3)

𝛾𝐹 𝑓 ⋅ 𝛥𝜏𝐸 ,2

𝛥𝜏𝐶/𝛾𝑀 𝑓
≤ 1.0 (2.4)

Simultaneous effect of normal and shear stresses

According to [1], Eq. 8.3, also the following design criteria are to be satisfied:

(
𝛾𝐹 𝑓 ⋅ 𝛥𝜎𝐸 ,2

𝛥𝜎𝐶/𝛾𝑀 𝑓
)

3

+ (
𝛾𝐹 𝑓 ⋅ 𝛥𝜏𝐸 ,2

𝛥𝜏𝐶/𝛾𝑀 𝑓
)

3

≤ 1.0 (2.5)

Nominal stresses : 𝛾Ff ⋅ 𝛥𝜎E,2 = 𝜆 ⋅ 𝛥𝜎
𝛾Ff ⋅ 𝛥𝜏E,2 = 𝜆 ⋅ 𝛥𝜏

Determination of partial safety factors 𝛾Mf and 𝛾Ff is described in Chapter 2.1.

The fatigue strength 𝛥𝜎C or 𝛥𝜏C for 2 ⋅ 106 cycles are assigned to the respective detail categories
in [1]. You can deduce the normal or shear stress ranges from the following diagrams.
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Figure 2.2: EN 1993-1-9, Figure 7.1

Figure 2.3: EN 1993-1-9, Figure 7.2
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2.2.2 Stress Range 𝛥𝜎

The stress range describes the difference between the maximum and the minimum normal or
shear stress (also called top and bottom stress). These are defined as follows:

𝛥𝜎 = 𝜎𝑚 𝑎𝑥− 𝜎𝑚 𝑖 𝑛 (2.6)

𝜎max : Maximum stress (with sign)

𝜎min : Minimum stress (with sign)

Figure 2.4: Stress ranges and influence of internal tensile stresses according to [2]

2.2.3 Damage Equivalent Factor 𝜆

The damage equivalent factors depend on the designed structural elements. They are described
in the respective standards. The following table shows the standards where you can find the rules
for calculation of the damage equivalent factors.

EN 1993-2 Steel bridges

EN 1993-3-1 Towers, masts and chimneys

EN 1993-3-2 Towers, masts and chimneys

EN 1993-4-1 Tank structures

EN 1993-4-2 Tank structures

EN 1993-4-3 Pipelines

EN 1993-6 Craneways

Table 2.1: Standards including damage equivalent factors

If there is no information on the damage equivalent factors 𝜆, the design requirements according
to [1], Annex A are applied. Then the nominal stress results from the damage equivalent factors
and the stress range.

𝛾𝐹 𝑓 ⋅ 𝛥𝜎𝐸 ,2= 𝜆 ⋅ 𝛥𝜎 (2.7)

𝛾𝐹 𝑓 ⋅ 𝛥𝜏𝐸 ,2= 𝜆 ⋅ 𝛥𝜏 (2.8)
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3 Input Data
After you open the add-on module, a new window appears. In this window, a navigator is dis-
played on the left, managing the tables that can be selected currently. The drop-down list above
the navigator contains the design cases (see Chapter 8.1, page 37).

The design-relevant data is defined in several input windows. When you open RF-STEEL Fatigue
Members for the first time, the following parameters are imported automatically:

• Members and sets of members

• Load cases, load and result combinations

• Materials

• Cross-sections

• Internal forces (in background, if calculated)

To select awindow, click the corresponding entry in the navigator. To set the previous or next input
window, use the buttons shown on the left. For scrolling in windows, you can also use the function
keys to select the next [F2] or previous [F3] window.

[OK] saves the results. Thus, you exit RF-STEEL EC3 and return to the main program. To exit
the add-on module without saving the new data, click [Cancel].

3.1 General Data

In the 1.1 General Data window, you can select the members, sets of members and actions you
want to design, as well as the relevant standard.

Figure 3.1: Window 1.1 General Data
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Design of
The design can be carried out forMembers as well as for Sets ofMembers. If you want to design only
selected objects, clear the All check box. Then you can access the text boxes to enter the numbers
of the relevant members or sets of members. You can remove the list of preset numbers in the text
box using the [Delete] button. Use the [Select] button todisplay theobjects graphically in the RFEM
work window.

When you design a set of members, the program determines the maximum stress ratio of all
members contained in the set of members. The results are shown in result windows 2.2 Design by
Set of Members and 4.2 Parts List by Set of Members.

Click [New] to create a new set of members. The dialog box that you already know from RFEM
appears where you can specify the parameters for a set of members.

Design Acc. to Standard
Currently, the design method is according to EN 1993-1-9 [1].

Existing Load Cases and Combinations
This column lists all load cases as well as load and result combinations that have been created in
RFEM.

RF-STEEL Fatigue Members can also design combinations of the RF-DYNAMmodule.

Use the button to transfer the selected entries to the Selected for Design list on the right. Alter-
natively, you can double-click the entries. To transfer the entire list to the right, use the button.

To transfer multiple entries of load cases, click the entries while pressing the [Ctrl] key, as common
for Windows applications. Thus, you can transfer several load cases at the same time.

Load cases marked in red, like LC 6 or LC 7 in Figure 2.1, cannot be designed: This happens when
the load cases are defined without any load data or the load cases contain only imperfections.
Then, when you transfer the load cases, a corresponding warning appears.

At the end of the list, several filter options are available. They will help you to assign the en-
tries sorted by load case, load combination, or action category. The buttons have the following
functions:

Select all cases in the list

Invert selection of load cases

Table 3.1: Buttons in tab Existing Load Cases

Selected for Design
The column on the right lists the load cases as well as the load and result combinations selected for
design. Use the button or double-click the entries to remove the selected items from the list.
Use the button to transfer the entire list to the left.

It is necessary to select several load combinations for the design in order to analyze the stress
differences (stress ranges)!

Comment
In this text box, you can enter user-defined notes, for example to describe the current design case.
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3.2 Materials

Thewindow is subdivided into two parts. The upper part lists all materials created in RFEM. TheMa-
terial Properties section shows the properties of the current material, that is, the table row currently
selected in the upper section.

Figure 3.2: Window 1.2Materials

Materials that will not be used in the design are dimmed. Materials that are not allowed are
highlighted in red. Modified materials are displayed in blue.

The material properties required for the determination of internal forces are described in Chap-
ter 4.3 of the RFEMmanual (Main Properties). Thematerial properties required for design are stored
in the global material library. These values are preset (Additional Properties).

You can adjust the units and decimal places of material properties and stresses using the menu
Settings → Units and Decimal Places (see Chapter 8.3, page 41).

Material Description
Thematerials defined inRFEMarepreset, but youcanalwaysmodify them: Todo this, click thema-
terial in column A. Then click or press function key [F7] to open the material list.

Figure 3.3: List of materials

Only materials of the “Steel” category are available in the list.
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When you have imported a material, the design-relevantMaterial Properties are updated.

If you change the material description manually and the entry is stored in the material library,
RF-STEEL Fatigue Members will import the material properties, too.

Generally, the material properties are not editable in the RF-STEEL Fatigue Members add-on mod-
ule.

Material Library
Numerous materials are already available in the library. To open the library, click

Edit → Material Library

or use the button shown on the left.

The followingMaterial Library dialog box appears.

Figure 3.4: Dialog boxMaterial Library

In the Filter section, the current Standard group is preset. Select the specificmaterial in theMaterial
to Select list. You can check the corresponding properties in the dialog section below.

Click [OK] or use the [↩] button to transfer the selectedmaterial toWindow1.2 of RF-STEEL Fatigue
Members.

Chapter 4.3 of the RFEM manual describes in detail how materials can be filtered, added, or re-
arranged.

You can also select materials of categories Cast Iron and Stainless Steel. Please check, however,
whether these materials are allowed by the design concept of the Standard [1].
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3.3 Cross-Sections

This window lists the cross-sections used for design. In addition, you can specify optimization
parameters here.

Figure 3.5: Window 1.3 Cross-Sections

Cross-Section Description
The cross-sections defined in RFEM are preset together with the assigned material numbers.

If you want to modify a cross-section, click the entry in column B. Click [Cross-Section Library] or
in the box or press function key [F7] to open the cross-section table of the current cross-section

box (see the following figure).

In this dialog box, you can select a different cross-section type. To select a different cross-section
category, click [Back to cross-section library] to access the general cross-section library.

Chapter 4.13 of the RFEMmanual describes how cross-sections can be selected from the library.
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Figure 3.6: IS cross-section types in the cross-section library

You can directly enter a new cross-section description in the input window. If the entry is listed in
the database, RF-STEEL FatigueMembers imports these cross-sections parameters, too. Amodified
cross-section will be highlighted in blue.

If the cross-sections in RF-STEEL Fatigue Members are different from the ones used in RFEM,
both cross-sections are displayed in the graphic on the right. The designs will be performed
for the cross-section selected in RF-STEEL Fatigue Members, using the internal forces from RFEM.

Max. Design Ratio
This column is displayed only after the calculation. It provides a decision support for the opti-
mization. By means of the displayed design ratio and colored relation scales, you can see which
cross-sections are little utilized and thus oversized, or overloaded and thus undersized.

Optimize
You can optimize every cross-section from the library: For the RFEM internal forces, the pro-
gram searches the cross-section that comes as close as possible to a user-defined maximum
ratio. You can define the maximum ratio in the Details dialog box (see Figure 4.2, page 20).

If you want to optimize a cross-section, open the corresponding drop-down list in column D or E
and select the desired entry: From current row or, if available, From favorites ‘Description’. Recom-
mendations for the cross-section optimization can be found in Chapter 8.2 on page 38.

Remark
This column shows remarks in the form of footers that are explained below the cross-section list.

A warning might appear before the calculation: Incorrect type of cross-section! It means that there
is a cross-section that is not stored in the database. This may be a user-defined cross-section or
a SHAPE-THIN cross-section that has not been calculated yet. To select an appropriate cross-section
for the design, click the [Library] button (see description below Figure 3.5).
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Member with Tapered Cross-Section
For taperedmembers with different cross-sections at themember start andmember end, themod-
ule displays both cross-section numbers in two rows, in accordance with the definition in RFEM.

RF-STEEL Fatigue Members also designs tapered members, provided that the cross-section at
the member start has the same number of stress points as the cross-section at the member end.
For example, the normal stresses are determined from the moments of inertia and the centroidal
distances of the stress points. If the cross-section at the start and the endof a taperedmember have
a different number of stress points, the intermediate values cannot be interpolated. The calculation
is possible neither in RFEM nor in RF-STEEL Fatigue Members.

To produce the samenumber of stress points, you can, for example, define the second cross-section
as a copy of the cross-section start with adjusted geometry parameters. The easiest way to do
this is to describe both cross-sections as parametric profiles. In such case, the cross-section type
IVU I-Section Plus Lower Flange is recommended.

Stress points of the cross-section including numbering can also be checked graphically: Select
the cross-section in Window 1.3 and click the [Info] button. The dialog box shown in Figure 3.7
appears.

Cross-Section Graphic
The right part of the window shows the currently selected cross-section.

The buttons below the graphic have the following functions:

Button Function

Open the Info About Cross-Section dialog box (see Figure 3.7)

Display or hide the cross-section dimensions

Display or hide the principal axes of the cross-section

Display or hide the stress points

Display or hide the numbering of stress points

Reset full view of the cross-section graphic

Table 3.2: Buttons of cross-section graphic
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Info About Cross-Section
In the Info About Cross-Section dialog box, you can see the cross-section properties, stress points,
and c/t-parts.

Figure 3.7: Dialog box Info About Cross-Section

Click [Details] to call up detailed information on stress points (centroidal distances, statical mo-
ments of area, warping constants etc.) and c/t-parts.

Figure 3.8: Dialog box Stress Points of HE A 400
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3.4 Detail Categories

In the 1.4 Detail Categories window, you can define the fatigue strength of members previously
selected for the design in Window 1.1.

Figure 3.9: Window 1.4 Detail Categories

Damage Equivalent Factor
Using the damage equivalent factors𝜆, which you can define separately for theNormal stresses and
Shear stresses, and the stress range 𝛥𝜎 or 𝛥𝜏 resulting from the existing load, the design-relevant
nominal stress is determined. The determination of the damage equivalent factors is subjected to
different standards (see Chapter 2.2.3, page 9).

Part of Set of Members No.
This column shows to which set of members a member belongs.

Settings - Member No.
In the bottom section of the window, you can define detail categories for the relevant stress points
of the cross-section. The selected stress point (cursor position in a table row) is highlighted in red
in the cross-section graphic. By clicking a stress point in the graphic, you select the relevant row
in the table.

Assigning detail categories facilitates the calculated determination of strength. The number of
detail categories represents the reference value of the fatigue strength 𝛥𝜎C or 𝛥𝜏C in N/mm.
You can obtain the detail categories with strengths from the tables 8.1 to 8.10 of the Eurocode [1].

It is also possible to use the list for a selection of the detail categories (Wöhler curves).

Below the Settings table, there is the Set input for members No. check box. If selected, the subse-
quent settings apply to the selectedmembers orAllmembers (you can enter themember numbers
manually or select themgraphically using the [Select] button). This option is useful when assigning
several members to the same boundary conditions.
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4 Calculation

4.1 Detail Settings

Before you start the [Calculation], it is recommended to check the design details. You can access
the corresponding dialog box in all windows of the add-on module by using the [Details] button.

The Details dialog box consists of the following tabs:

• Ultimate Limit State

• General

4.1.1 Ultimate Limit State

Figure 4.1: Dialog box Details, tab Ultimate Limit State

Assessment Method
The reliability concept and possible consequence of failure affect the partial safety factor 𝛾Mf

considered when determining the fatigue strength. You can set this partial safety factor using
the option Damage tolerant or Safe life together with the Consequence of failure (low or high).

You can also specify the partial factor 𝛾Mf for fatigue strength directly.

[1], Table 3.1 shows recommendations for the factor 𝛾Mf (see Figure 2.1, page 6).
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4.1.2 General

Figure 4.2: Dialog box Details, tab General

Cross-Section Optimization
The optimization is targeted on the maximum stress ratio of 100 %. If necessary, you can set
a different design ratio in this text box.

Display Result Windows
In this dialog section, you can select the result tables including parts list that you want to be
displayed. Those windows are described in Chapter 5.
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4.2 Calculation Start

In all input windows of the RF-STEEL Fatigue Members add-on module, you can start the calcula-
tion using the [Calculation] button.
RF-STEEL FatigueMembers searches for the results of the load cases, load combinations and result
combinations to be designed. If these cannot be found, the program starts the RFEM calculation
to determine the design-relevant internal forces.
You can also start the calculation in the RFEM user interface: The To Calculate dialog box (menu
Calculate→ ToCalculate) lists design cases of the add-onmodules like load cases and load com-
binations.

Figure 4.3: Dialog box To Calculate

If the RF-STEEL Fatigue Members design cases are missing in the Not Calculated section, select All
or Add-onModules in the drop-down list below the section.

Use the button to transfer the selected RF-STEEL Fatigue cases to the list on the right. Click
[OK] to start the calculation.

To calculate a design case directly, you can also use the list in the toolbar: Select the RF-STEEL
Fatigue Members design case in the toolbar list and click [Show Results].

Figure 4.4: Direct calculation of RF-STEEL Fatigue Members case in RFEM

Subsequently, you can see the design process in a separate dialog box.
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5 Results
The 2.1 Design by Cross-Sectionwindow is displayed immediately after the calculation.

Figure 5.1: Result windows with designs and design ratios

The designs are shown in result windows 2.1 to 2.5, sorted by different criteria.

Windows 4.1 and 4.2 show the parts lists by member and set of members.

Every window can be selected by clicking the corresponding entry in the navigator. To set the pre-
vious or next window, use the buttons shown on the left. You can also use the function keys to
select the next [F2] or previous [F3] window.

[OK] saves the results. You exit RF-STEEL Fatigue Members and return to the main program.

Chapter 5 - Results describes the different result windows one by one. The evaluation of and
checking results is described in Chapter 6 - Results Evaluation, page 29 ff.
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5.1 Design by Cross-Section

In this result window, the maximum design ratios of all designed members and actions are listed
by cross-section. The ratios for the internal forces of the governing load cases and combinations
are sorted by stress type.

Figure 5.2: Window 2.1 Design by Cross-Section

Section No.
The results are listed by cross-section number. The description of the cross-section is displayed
on the right of the cross-section number.

Member No.
It shows the number of the member with the maximum design ratio of the design type indicated
in column F.

Location x
This column shows the respective x-location where the member's maximum design ratio occurs.
For the output in form of tables, the program uses the following member locations x:

• Start and end node

• Division points according to possibly defined member division (see RFEM Table 1.16)

• Member division according to specification for member results (Calculation Parameters dialog
box, Global Register Parameters tab in RFEM)

• Extreme values of internal forces
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S-point No.
The design is carried out on certain stress points of the cross-section. These points are defined
by centroidal distances, statical moments, and cross-section thicknesses, which allow for design
according to [1]. The cross-section dialog graphic in the bottom right shows the currently selected
stress point (that means the stress point of the table row where the pointer is placed) highlighted
in red.

To check the stress point properties, click the [Info] button (see Chapter 3.2, page 17).

Design Ratio
Columns D and E show the design conditions according to [1].

The length of colored bars represents the respective design ratios.

Design According to Formula
This column displays the individual fatigue designs according to [1], Clause 8.

5.2 Design by Set of Members

Figure 5.3: Window 2.2 Design by Set of Members

This result window appears when you have selected at least one set of members for the design.
The window lists the maximum design ratios sorted by set of members.

The columnMember No. shows the number of the one member within the set of members that
bears the maximum stress ratio for the respective stress types.

The output by sets of members clearly presents the design for an entire structural group (for
example a continuous beam).
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5.3 Design byMember

Figure 5.4: Window 2.3 Design byMember

This resultwindowpresents themaximumdesign ratios for different stress types sortedbymember
number. The columns are described in detail in Chapter 5.1 on page 23.

If there is a tapered member, both cross-section descriptions are displayed in the table row next
to the section number.
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5.4 Design by x-Location

Figure 5.5: Window 2.4 Design by x-Location

This result window lists the maximum stresses for each member at all location x resulting from
the division points defined in RFEM:

• Start and end node

• Division points according to possibly defined member division (see RFEM Table 1.16)

• Member division according to specification for member results (Calculation Parameters dialog
box, Global Register Parameters tab in RFEM)

• Extreme values of internal forces
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5.5 Parts List byMember

Finally, there is a summary of all cross-sections included in the design case.

Figure 5.6: Window 4.1 Parts List byMember

By default, this list contains only the designed members. If you need a parts list for all members
of the model, select the corresponding option in the Details dialog box (see Figure 4.2, page 20).

Part No.
The program automatically assigns part numbers to similar members.

Cross-Section Description
This column lists the cross-section numbers and descriptions.

Number of Members
This column shows howmany similar members are used for each part.

Length
This column shows the respective length of an individual member.

Total Length
This column shows the product determined from the two previous columns.

Surface Area
For each part, the program indicates the surface area relative to the total length. The surface area
is determined from the Surface Area of the cross-sections that can be seen in Windows 1.3 and
2.1 to 2.5 in the cross-section properties (see Figure 3.7, page 17).
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Volume
The volume of a part is determined from the cross-sectional area and the total length.

Unit Weight
The Unit Weight of the section is relative to the length of one meter. For tapered cross-sections,
the program averages both cross-section weights.

Weight
Thevaluesof this columnaredetermined fromthe respectiveproductof theentries in columnsCandG.

Total Weight
The final column indicates the total weight of each part.

Sum
At the bottom of the list, you find a summary of the values in the columns B, D, E, F, and I. The last
row of the Total Weight column informs you about the total amount of required steel.

5.6 Parts List by Set of Members

Figure 5.7: Window 4.2 Parts List by Set of Members

The last result window is displayed if you have selected at least one set of members for design.
The window summarizes an entire structural group (for example a horizontal beam) in a parts list.

Details on the various columns can be found in the previous Chapter 5.5. If there are different
cross-sections used in a set of members, the program averages the surface area, the volume and
the cross-section weight.
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6 Results Evaluation
For the evaluation process, you can use the buttons below the table.

Figure 6.1: Buttons for results evaluation in tables

The buttons have the following functions:

Button Description Function

Color Bars Display or hide colored relation scales in the result windows

Filter Parameter
Describe the criterion for filtering results in tables: ratios
greater than 1, maximum or user-defined limit

Apply Filter
Display only the rows with the filter parameter applied (design
ratio > 1, maximum, user-defined limit)

Result Diagrams
Open the Result Diagram onMemberwindow
→ Chapter 6.2, page 31

Excel Export
Export the table to MS Excel / OpenOffice
→ Chapter 8.4.2, page 42

Member Selection Select a member graphically to display its results in the table

View Mode Jump to the RFEM work window to change the view

Table 6.1: Buttons in the result windows 2.1 to 2.4

6.1 Results in RFEMModel

You can also evaluate the design results in the RFEM work window.
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RFEM Background Graphic and ViewMode
The RFEM work window in the background is useful when you want to find the position of a par-
ticular member in the model: The member selected in the result window of RF-STEEL Fatigue
Members is highlighted in the selection color in the background graphic. An arrow indicates also
the member's x-location that is displayed in the active table row.

Figure 6.2: Indication of member and current Location x in the RFEMmodel

In case you cannot improve the display by moving the RF-STEEL EC3 module window, click [Jump
to Graphic] to activate the View mode: The program hides the window so that you can modify
the display in the RFEM user interface. The viewmode provides the functions of the Viewmenu,
for example zooming, moving, or rotating the display. The pointer remains visible.

Click [Back] to return to the RF-STEEL Fatigue Members add-on module.

RFEMWorkWindow
You can also graphically check the design ratios and stress ranges in the RFEMmodel: Click [Graph-
ics] to exit the design module. In the RFEM work window, the design ratios are now displayed like
the internal forces of a load case.

In the Results navigator, you can specify which design ratios or stress ranges you want to display
in the graphic.

To turn the display of design results on or off, click the [Show Results] button, that you know from
the display of internal forces in RFEM. To display the result values, click the [Show Values] toolbar
button on the right.

The RFEM tables are not relevant for the evaluation of the design results.

You can set the design cases by means of the list in the RFEMmenu bar.

To adjust the graphical representation of the results, you can select Results→Members in theDis-
play navigator. The display of the stresses and design ratios is Two-Colored by default.
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Figure 6.3: Display navigator: Results→Members

If you select amulticolor representation (optionsWith/WithoutDiagramorCross-Sections), the color
panel becomes available, providing common control functions. These functions are described
in detail in the RFEMmanual, Chapter 3.4.6.

Figure 6.4: Design ratios with display optionsWith Diagram and Result Diagrams Filled

You can transfer the graphics of stresses and design ratios to the printout report (see Chapter 7.2,
page 35).

To return to the add-on module, click [RF-STEEL Fatigue Members] in the panel.

6.2 Result Diagrams

You can also graphically evaluate distributions of member's results in a result diagram.

To do this, select the member (or set of members) in the RF-STEEL Fatigue Members result window
by clicking in the table row of the member. Then, open the Result Diagram onMember dialog box
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by clicking the button shown on the left. The button is located below the upper result table (see
Figure 6.1, page 29).

To display the result diagrams, select the command from the RFEMmenu

Results → Result Diagrams for SelectedMembers

or use the corresponding button in the RFEM toolbar.

A window opens, graphically showing the distribution of the results on themember or set of mem-
bers.

Figure 6.5: Dialog box Result Diagram onMember

Use the list in the toolbar above to choose the relevant RF-STEEL Fatigue Members design case.

The Result Diagram onMember dialog box is described in detail in the RFEMmanual, Chapter 9.5.

6.3 Filter for Results

The RF-STEEL Fatigue Member result windows allow you to sort the results by various criteria.
In addition, you can use the filter options described in Chapter 9.9 of the RFEMmanual to evaluate
the design results graphically.
You can use the Visibility option also for RF-STEEL Fatigue Members (see RFEM manual, Chap-
ter 9.9.1) to filter the surfaces and members in order to evaluate them.

Filtering Designs
The design ratios can easily be used as filter criteria in the RFEM work window, which can be
accessed by clicking [Graphics]. To apply this function, the panel must be displayed. If the panel
is not active, you can activate it in the RFEMmenu by clicking

View → Control Panel (Color Scale → Factors → Filter)

or use the toolbar button shown on the left.



6 Results Evaluation

©Dlubal Software GmbH 2015

33

6
The panel is described in the RFEMmanual, Chapter 3.4.6. The filter settings for the results must
be defined in the first panel tab (Color scale). As this tab is not available for the two-colored
results display, you have to set the display option ColoredWith/Without Diagram or Cross-Sections
in the Display navigator.

Figure 6.6: Filtering stress ranges with adjusted color scale

As the figure above shows, the color scale can be set in such a way that only stress ranges greater
than 45 N/mm2 are shown in a color range between blue and red. Furthermore, the color scale
can be adjusted in such a way that one color range covers exactly 2.5 N/mm2, for example.

The Display Hidden Result Diagram function in the Display navigator (Results → Members) shows
all stress diagrams that are not within this value spectrum. Those diagrams are represented by
dotted lines.

FilteringMembers
In the Filter tab of the control panel, you can specify the numbers of particular members to display
their results filtered. This function is described in detail in the RFEMmanual, Chapter 9.9.3.
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Figure 6.7: Member filter for stress ranges of a beam

In contrast to the visibility function, the model will be displayed completely in the graphic. The fig-
ure above shows the stress ranges of a beam. The remaining designed members are displayed in
the model but without 𝛥𝜎 results.
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7 Printout

7.1 Printout Report

Similar to RFEM, the programgenerates a printout report for the RF-STEEL FatigueMembers results,
to which you can add graphics and descriptions. The selection in the printout report determines
what data from the design module will be included in the printout.

The printout report is described in the RFEM manual. In particular, Chapter 10.1.3.4 Selecting
Data of Add-onModules describes how to select input and output data from add-on modules for
the printout report.

For complex structural systems with many design cases, it is recommended to split the data
into several printout reports, thus allowing for a clearly-arranged printout.

7.2 Graphic Printout

In RFEM, you can add every picture that is displayed in the work window to the printout report
or send it directly to a printer. In this way, you can prepare the design and stress ratios displayed
in the RFEMmodel for the printout, too.

The printing of graphics is described in the RFEMmanual, Chapter 10.2.

7.2.1 Results in RFEMModel

To print the currently displayed graphic of the design ratios or stress ranges, click

File → Print Graphic

or use the toolbar button shown on the left.

Figure 7.1: Button Print Graphic in RFEM toolbar

7.2.2 Result Diagrams

Also in the Result Diagram onMember dialog box (see Figure 6.5, page 32), you can click [Print] to
transfer the graphic to the printout report or print it directly.

Figure 7.2: Button Print in the dialog box Result Diagram onMember

The following dialog box appears:
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Figure 7.3: Dialog box Graphic Printout, tab General

The dialog box is described in the RFEMmanual, Chapter 10.2. The RFEMmanual also describes
the Options and Color Scale tab.

You can move the graphic anywhere within the printout report by using the drag-and-drop func-
tion.

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the naviga-
tor of the printout report. The Properties option in the shortcut menu opens the Graphic Printout
dialog box, offering various options for adjustment.

Figure 7.4: Dialog box Graphic Printout, tab Options
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8 General Functions
This chapter describes useful menu functions as well as export options for the designs.

8.1 Design Cases

Design cases allow you to group members for a design. In this way, you can combine groups
of structural elements or analyze members with particular design specifications (for example
modified materials, detail categories, optimization).

It is no problem to analyze the same member or set of members in different design cases.

To calculate a RF-STEEL FatigueMembers design case, you can also use the load case list in the RFEM
toolbar.

Create NewDesign Case
To create a new design case, use the RF-STEEL Fatigue Members menu and click

File → New Case.

The following dialog box appears:

Figure 8.1: Dialog box New RF-STEEL FatigueMembers-Case

In this dialog box, enter aNumber (that is still available) for the newdesign case. The corresponding
Descriptionmakes the selection in the load case list easier

Click [OK] to open the RF-STEEL Fatigue Members window 1.1 General Datawhere you can enter
the design data.

Rename Design Case
To change the description of a design case, use the RF-STEEL Fatigue Members menu and click

File → Rename Case.

The following dialog box appears:

Figure 8.2: Dialog box Rename RF-STEEL FatigueMembers-Case

In this dialog box, you can specify a differentDescription as well as a differentNumber of the design
case.

Copy Design Case
To copy the input data of the current design case, use the RF-STEEL Fatigue Members menu and
click

File → Copy Case.
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The following dialog box appears:

Figure 8.3: Dialog box Copy RF-STEEL FatigueMembers-Case

Define the Number and, if necessary, a Description of the new case.

Delete Design Case
To delete design cases, use the RF-STEEL Fatigue Members menu and click

File → Delete Case.

The following dialog box appears:

Figure 8.4: Dialog box Delete Cases

You can select a design case in the list of Available Cases. To delete the selected case, click [OK].

8.2 Cross-Section Optimization

The RF-STEEL Fatigue Members design module provides an option to optimize overloaded or lit-
tle utilized cross-sections. To do this, open the drop-down lists in columns D or E of the relevant
cross-sections in the 1.3 Cross-Sections window and select whether the cross-sections should be
determined From the current row or from the user-defined Favorites (see Figure 3.5, page 14).
You can also start the cross-section optimization in the result windows by using the shortcut
menu.

Figure 8.5: Shortcut menu for cross-section optimization

During the optimization process, RF-STEEL Fatigue Members determines the cross-section that
fulfills the analysis requirements in the most “optimal” way, that is, it comes as close as possible to
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the maximum allowable design ratio specified in the Details dialog box (see Figure 4.2, page 20).
The required cross-section properties are determined with the internal forces from RFEM. If an-
other cross-section proves to be more favorable, this cross-section is used for the design. Then,
the graphic in Window 1.3 shows two cross-sections: the original cross-section from RFEM and
the optimized one (see Figure 8.7).

When optimizing a parametrized cross-section, the Optimization dialog box appears.

Figure 8.6: Dialog box Thin-Walled Cross-Sections - Symmetric I-Section: Optimize

By selecting the check boxes in the Optimize column, you decide which parameter(s) you want to
modify. This enables theMinimum andMaximum columns, where you can specify the upper and
lower limits of the parameter. The Increment column determines the interval in which the size of
the parameter varies during the optimization process.

If you want to Keep current side proportions, select the corresponding check box. In addition,
you have to select at least two parameters for optimization.

Cross-sections composed of combined rolled cross-sections cannot be optimized.

Please note that the internal forces are not automatically recalculated with the modified cross-sec-
tions during the optimization: It is up to you to decide which cross-sections should be transferred
to RFEM for recalculation. As a result of optimized cross-sections, the internal forces may differ
significantly because of the modified stiffnesses in the structural system. Therefore, it is recom-
mended to recalculate the internal forces of the modified model data after the first optimization
and then to optimize the cross-sections once again.

You can export the modified cross-sections to RFEM: Go to the 1.3 Cross-Sectionswindow and click

Edit → Export All Cross-Sections to RFEM.

You can also use the shortcut menu in Window 1.3 to export optimized cross-sections to RFEM:
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Figure 8.7: Shortcut menu in window 1.3 Cross-Sections

Before themodified cross-sections are transferred to RFEM, a security query appears as to whether
the results of RFEM should be deleted.

Figure 8.8: Query before transfer of modified cross-sections to RFEM

By confirming the query and starting the [Calculation] in the RF-STEEL Fatigue Members module,
the RFEM internal forces as well as the design ratios will be determined in one single calculation
run.

If the modified cross-sections have not been exported to RFEM yet, you can reimport the original
cross-sections in the design module by using the options shown in Figure 8.7. Please note that
this option is only available in the 1.3 Cross-Sectionswindow.

If you optimize a tapered member, the programmodifies the member start and end and linearly
interpolates the secondmoments of area for the intermediate locations. Since these moments are
considered with the fourth power, the designs may be inaccurate if the depths of the start and
end cross-section differ considerably. In such a case, it is recommended to divide the taper into
several members, thus modeling the taper layout manually.
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8.3 Units and Decimal Places

Units and decimal places of RFEM and the add-on modules are managed in one dialog box.
In RF-STEEL FatigueMembers, you can use themenu to adjust the units. To open the correspond-
ing dialog box, click

Settings → Units and Decimal Places.

The followingdialogbox appearswhich you already know fromRFEM. RF-STEEL FatigueMembers
is preset in the Program /Module list.

Figure 8.9: Dialog box Units and Decimal Places

You can save the settings as a user profile to reuse them in other models. These functions are
described in Chapter 11.1.3 of the RFEMmanual.

8.4 Data Transfer

8.4.1 Exporting Materials to RFEM

When you have adjusted the materials in RF-STEEL Fatigue Members for design, you can export
themodifiedmaterials to RFEM in a similarway as you export cross-sections: Open the 1.2Materials
window and then use the menu

Edit → Export All Materials to RFEM.

You can also export the modified materials to RFEM using the shortcut menu in Window 1.2.

Figure 8.10: Shortcut menu in the window 1.2Materials
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Before themodified cross-sections are transferred to RFEM, a security query appears as to whether
the results of RFEM should be deleted. By confirming the query and starting the [Calculation] in
the RF-STEEL Fatigue Members module, the RFEM internal forces as well as the design ratios will
be determined in one single calculation run.

If the modified cross-sections have not been exported to RFEM yet, you can reimport the original
cross-sections in the design module by using the options shown in Figure 8.10. Please note,
however, that this option is only available in the 1.2Materialswindow.

8.4.2 Exporting Results

The RF-STEEL Fatigue Members results can also be used by other programs.

Clipboard
To copy cells selected in the result windows to the Clipboard, use the keys [Ctrl]+[C]. Press [Ctrl]+[V]
to insert the cells, for example in a word processing program. The headers of the table columns
will not be transferred.

Printout report
You can print the data of RF-STEEL Fatigue Members in the global printout report (see Chapter 7.1,
page 35) to export them subsequently. Then, in the printout report, click

File → Export to RTF.

The function is described in the RFEMmanual, Chapter 10.1.11.

Excel / OpenOffice
RF-STEEL Fatigue Members provides a function for directly exporting data to MS Excel, OpenOf-
fice.org Calc, or the CSV file format. To open the corresponding dialog box, click

File → Export Tables.

The following export dialog box appears:

Figure 8.11: Dialog box Export - MS Excel
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When you have selected the relevant options, you can start the export by clicking [OK]. Excel or
OpenOffice will be started automatically, you do not need to open the programs first.

Figure 8.12: Results in Excel
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9 Example: Tubular Truss
In the following example from [2], we examine a 36 m long ceiling beam of a machine hall formed
as a planar truss. The beam is to be variably stressed by machine loads. These loads represent
the upper loads, that means the loading varies between zero and the maximum value. The result
is a constant stress range corresponding to the magnitude of the represented loads.

9.1 System and Loads

Figure 9.1: Planar truss, constant stress range

Cross-Sections
Top chord: RO 219.1x7.1 (DIN EN 10220)

Struts: RO 88.9x4 (DIN EN 10220)

Bottom chord: RO 177.8x7.1 (DIN EN 10220)

Material
Structural steel S 235 (EN 10025-2:2004-11)

Figure 9.2: Node 6 in bottom chord of the truss
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Determination of Member Loading
The beam is modeled with continuous chords and flexibly connected struts. The calculation
of the structure provides the following normal forces and bending moments for the members
on Node 6.

Figure 9.3: Internal forces N andMy on Node 6

The internal forces can be presented as a load combination consisting of two load cases:

Load case 1: Normal forces in equilibrium

Load case 2: Remaining internal forces in chord (normal forces and bending)

Figure 9.4: Load cases for Node 6
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Nominal Stress Range of Critical Components
As pictured in Figure 9.3, the governing stress is in Chord 1, since there is the major tension force.
Only Strut 2 of both diagonals is subjected to the tension force.

Load case 1: Normal forces in equilibrium

𝜎𝑏,𝑎𝑥 =
17.2
1070

⋅ 103 = 16.07 N/mm2

Load case 2: Remaining internal forces in chord

𝜎𝑐 ℎ,𝑐 ℎ =
228.50
3807

⋅ 103 −
0.786 ⋅ 106

0.156 ⋅ 106 = 55.0 N/mm2

Bending moments in the chord reduce the tension force of the chord on the side where the struts
are connected.

In order to consider the actions of secondary bendingmoments, the nominal stress rangemust be
multiplied by the increase factors k1 according to [1], Tab 4.1. A factor of 1.3 applies for the stuts
and a factor of 1.5 for the chords.

Load case 1: Normal forces in equilibrium

𝜎𝑏,𝑎𝑥 = 1.3 ⋅ 16.07 = 20.90 N/mm2

Load case 2: Remaining internal forces in chord

𝜎𝑐 ℎ,𝑐 ℎ = 1.5 ⋅ 55.0 = 82.50 N/mm2

Selection of Detail Category Class
When applying the nominal stress concept, the construction details for welded nodes of trusses
are covered in detail categories of [1], Tab. 8.7. Application of the detail categories is possible
only in compliance with specific geometrical boundary conditions. Parameters of the nodes
in the example are within the allowable limits.

For the wall thicknesses ratio of tubes t0/ti = 1.775, the detail category 45 is applicable.

Fatigue Design and Lifetime of Node 6
With the detail category 𝜎C = 45 N/mm2 for 2 ⋅ 106 cycles and the partial safety factor 𝛾Mf = 1.15,
a number of the maximum possible stress cycles ensues from the general form of the fatigue
strength curve or the S-N curve (Wöhler curve) until the fatigue failure occurs.

For the existing structural details according to [1], Tab. 8.7, the S-N curve inclinations is m = 5.
The governing location is the main chord with the maximum stress range 𝜎ch,ch = 83 N/mm2.

𝑁𝑅 = 2 ⋅ 106 ⋅
(𝛥𝜎𝐶/𝛾𝑀 𝑓)

𝑚

𝛥𝜎𝑚
𝑐 ℎ,𝑐 ℎ

= 2 ⋅ 106 ⋅
(45/1.15)5

835 = 46660 cycles

The damage equivalent factor 𝜆 is obtained from the general formula as:

𝜆 = (
1

2 ⋅ 106 ⋅
𝑛

∑
𝑖

(
𝛥𝜎𝑐 ℎ,𝑐 ℎ

max 𝛥𝜎
)

𝑚

⋅ 𝑛𝐸)
1
u�

= (
1

2 ⋅ 106 ⋅
𝑛

∑
𝑖

(
83
83

)
5

⋅ 46660)
1
5

= 0.471
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9.2 Design in RF-STEEL FatigueMembers

9.2.1 Definition of Detail Category

Similarly to the failure graphic of the detail category 45 in [1], Tab. 8.7, the governing design area
is the upper area of the bottom chord member (Chord 1). The design-relevant stress points are
implemented for each cross-section in the cross-section library. In our example, tubular stress
points 8 to 12 are relevant for the design. You can assign the corresponding detail category
for these stress points in the 1.4 Design Categorieswindow.

Figure 9.5: Window 1.4 Detail Categories

In Window 1.4, you can also define the damage equivalent factor for the bottom chord member.
Due to preliminary considerations with the determination of the maximum load cycle as well as
retroactive calculationof the respectivedamageequivalent factors, thedesign ratio is set to 100%
in RF-STEEL Fatigue Members.

9.2.2 Limitation of Direct Stress Ranges

In the 2.1 Design by Cross-Sectionwindow, the design ratio for the limitation of direct stress range
is set to 24 %.



9 Example: Tubular Truss

©Dlubal Software GmbH 2015

48

9

Figure 9.6: Window 2.1 Design by Cross-Section - Limitation of direct stress range

Limitation of stress ranges

𝛥𝜎 ≤ 1.5 ⋅ 𝑓𝑦

82.93 ≤ 1.5 ⋅ 235

82.93 ≤ 352.5

Check:
82.93
352.5

= 0.24 ≤ 1.00

The serviceability limit state design is thus fulfilled.
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9.2.3 Design of Nominal Direct Stress Range

For the design of nominal direct stress range according to [1], Clause 8(2), the design ratio is
set to 100%.

Figure 9.7: Window 2.1 Design by Cross-Section - Design for nominal direct stress range

Direct stresses

𝛾𝐹 𝑓 ⋅ 𝛥𝜎𝐸 ,2= 𝜆 ⋅ 𝛥𝜎

𝛾𝐹 𝑓 ⋅ 𝛥𝜎𝐸 ,2= 0.471 ⋅ 82.93

𝛾𝐹 𝑓 ⋅ 𝛥𝜎𝐸 ,2= 38.977 N/mm2

Check:
𝛾𝐹 𝑓 ⋅ 𝛥𝜎𝐸 ,2

𝛥𝜎𝐶/𝛾𝑀 𝑓
≤ 1.00

38.977
45/1.15

≤ 1.00

1.00 ≤ 1.00
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